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Important Information and Disclaimers 

 

• Microsoft Corporation, through its Microsoft Research division, is providing this 

information as a courtesy to end users to assist you with using a laser cutter/engraver as 

well as generating designs in Microsoft’s Visio. Microsoft is not a manufacturer of laser 

cutters or other materials described in this manual and assumes no responsibility for your 

use of any laser cutter or any materials you use with the laser cutter, regardless of whether 

you are applying this information. YOU USE THIS INFORMATION AT YOUR OWN 

RISK. MICROSOFT AND ITS AFFILIATES DISCLAIM ALL RESPONSIBILITY FOR 

HARM OR DAMAGE TO YOU, YOUR MATERIALS, SURROUNDINGS AND/OR 

YOUR USE OF YOUR LASER CUTTER. 

 

• If you share this document, share it in its entirety,  with a proper attributes to Microsoft. 

 

• Familiarize yourself with the owner’s manual for your laser cutter before using it. Refer 

often to the owner’s manual when using your laser cutter.  

 

THIS DOCUMENT IS BASED ON A SPECIFIC LASER WE USE: In Microsoft Research, 

we have a Universal Laser Systems model PLS6.60, which is equipped with an 80-watt carbon-

dioxide laser and energy wavelength output of 10.6 microns. This laser has a 2.0” fl lens. The 

PLS6.60  has a low-power, visible red laser, when enabled and the higher-power carbon-

dioxide laser is disabled, for safely indicating the cutting or etching path. The laser cutter also 

has an aluminum honeycomb floor as its cutting platform.  Whether your configuration is 

similar or not, you are advised to adjust the information in this document to match your 

specific configuration. ALL LASERS AND LASER SYSTEMS ARE DIFFERENT. USE 

CARE WHEN USING THIS INFORMATION WITH YOUR LASER CUTTER. MAKE 

SURE YOU ARE CLEAR TO USE YOUR MATERIAL IN THE LASER SYSTEM AND 

THAT THE EXHAUST AND FILTRATION SYSTEM IS APPROVED  FOR THIS 

MATERIAL, ESPECIALLY IF HAZARDOUS GASSES ARE PRODUCED. MAKE SURE 

YOU HAVE READ AND ARE ABIDING BY THE MSDS SHEET FOR THAT MATERIAL.  
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• Familiarize yourself with the locations of nearby fire extinguishers. 

 

• The laser-cutting system should be used only in well-ventilated areas. Vent properly to the 

outside or to a suitable filter system. Make sure the exhaust system and air assist are 

turned on.  

 

 

Background and Compatible Materials 

This document describes how we use the laser cutter and Microsoft Office Visio® with our Universal 

Laser Systems laser cutter to engrave and cut some plastics, ceramics, woods, coated metals, and other 

materials. Make sure your management, venting system and filtering system are compatible with the 

materials.  

a. Plexiglas (acrylic): One of the best, least-expensive plastics and the easiest to cut. Tends 

to be brittle in small or thin features. Comes in all shapes, sizes, and colors. Durability 

varies with type; some acrylics are less brittle than others. Note that the berm produced 

varies with manufacturer and can influence subsequent gluing operations. 

b. Delrin (acetal): Structurally, perhaps the “best” plastic. It is extremely strong, durable, 

more flexible than acrylic, and naturally slippery. It also is one of the most expensive 

plastics. Comes in black or off-white only. Delrin is a little harder to cut than acrylic Do 
not use glues or any other kind of adhesive on Delrin – few things stick to it. It can be 

welded with heat, the laser cutter (see welding section on this) or fastened with screws. 

Be very careful with Delrin. The vapors are very flammable, bordering on explosive, 

and can catch fire with an almost invisible blue flame. Avoid cutting very thin 

sections as these can (read will) catch fire.  

c. Lexan (polycarbonate): Much stronger, more durable, and more flexible than acrylic, but 

harder to cut. Edges tend to burn or yellow easily, making it difficult to get a clean cut. 

It’s difficult to cut this material thicker than ~1/4”. Keep the protective sheet on both 

sides while cutting, as this reduces yellowing of the non-cut portions. 

d. Styrene: It burns easily and leaves a ridge on the edge (berm). Flexible (not brittle), but 

not as strong as other plastics. 

e. Polyethylene Terephthalate PET. Similar mechanical properties to polycarbonate, but 

edges cut a lot cleaner, though yellowing occurs near the edges – keep the protective film 

on. Cannot be glued with acrylic glue. 

f. ABS: Similar to acrylic but more durable and flexible. 

g. HDPE: Durable but hard to cut over ~1/4”, leaves a berm. 

h. PVC, vinyl, materials with chlorine – These materials are not allowed in the laser 

cutter because of the highly toxic fumes (chlorine). 

 

 

SPECIFICATIONS FOR THE LASER CUTTER:  

1. Work space: 32” wide  x  18” deep (for our device). Origin is the upper left corner. 

2. Spot size (when focused): approximately 0.005” using the 2” FL lens 

3. Depth of field: approximately +/- 0.1” 

4. Movement resolution of head: ~0.001” 

5. Kerf (material removed during a cut): approximately +/- [0.003”-0.006”]  ~(0.006”- 0.012” 

total, both sides) 



 

Laser-Cutter Safety 

When using your laser cutter:  

1) Ensure that you have a readily accessible fire extinguisher. 

2) Only use your laser cutter in a well-ventilated area. 

3) Remember that cutting certain materials, such as PVC, can create toxic fumes. 

4) Do Not leave a laser job unattended. Monitor the laser cutter until the job is finished. 

5) An approved fire extinguisher and/or fire blanket should be close at hand. 

6) Adhere to the local regulations concerning your laser cutter. 

 

Terms: 

 

Kerf is the material removed during a cut: ~+/- [0.003” - 0.006”]  ~(0.006”- 0.012” total, both 

sides).    

 

The exit kerf will be slightly smaller (by 0.002”-0.004”) at the bottom than at the beam entrance for 

thick plastic. This means the cut piece will be 0.002”-0.004” larger at the bottom that the top. This 

depends on the material property, thickness, and beam focus. For a slightly squarer cut, move the 

focus point about a third of the way down from the top surface. This might require a slight increase 

in power and could cause a slight rounding of the top edges of the cut. 

 
Berm is the material build-up near cut edges, top and bottom. 

There might be a noticeable lip or berm at the cut edges. Check with your fingernail. You might 

have to remove this with a file or scrape with a sharp metal edge, such as a razor blade, knife or a 

pair of scissors, if this is an issue when stacking multiple layers or gluing. Some acrylics (cast or 

‘Chemcast’, ‘Optix’ with a brown paper film) will produce less of a berm than other types (extruded 

- with blue plastic film). 

 

PREPARING THE LASER CUTTER: 

 

1. A new job: If starting a new laser cutting job, there are rulers along the X=0, Y=0 borders that 

are black with white markings that become dirty quickly. A short time after you have used your 

laser cutter, these markings will become unreadable from the affluent produced and may not be 

able to be cleaned. Cover the markings with thick transparent tape (packing tape). When the 

markings become unreadable, simply replace the tape. A separately etched plastic strip can also 

be used. Etch deeply. The black soot left can sometimes be removed with methylene chloride 

(acrylic solvent). Use in a well ventilated space. 

2. Placing material in the cutter: Open the lid and place material in the cutter, firmly against the 

upper-left 90-degree reference stop or any other place on the honeycomb floor, but note the 

position where the cutting will take place. Be careful not to gouge the expanded metal bed near 

the origin when loading large sheets of material. 
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3. Setting the cutting position: You can draw the piece to be cut at the appropriate place on 

Visio’s 32” x 18” drawing area, keeping the origin at the upper left of the drawing. Do not draw 

anything that touches or crosses the 32” x 18” border. Refer to the manual.   

4. Focusing: Note: Our new PLS 6.60 laser cutter has “automatic focusing” where all you specify 

is the Z-thickness of the material being cut.  

a. For manual focusing: Eyeball the height of the piece with regard to the end of the air-

assist nozzle to make sure it won’t crash into the piece when moved from its home resting 

place (the upper right) to the cutting area. If it appears that the head won’t clear when 

rapidly moved to the focus position, remove the material, lower the table to a safe height, 

using the down arrow when in the focus mode. As soon as you push the Z button to enter 

the focus mode, the head will move rapidly to the focus position, usually near the origin 

in the upper left. With the lid open, press Z on the cutter, and use the manual focusing 

tool to focus in the area you will be cutting, moving the head with the X, and Y buttons 

as described in the manual. After focusing, remove the tool and press Z to re-home the 

head. Use SELECT and ESCAPE on the laser cutter to get to the file menu, the normal 

mode of use.  

5. Printing: From the local PC, “print” the job on the laser cutter. You can set the laser mode, 

power, speed, and PPI from the Preferences button with the Print selection.  More later. 

6. Viewing laser path before cutting: To see the laser-cutting path before cutting, open the lid and 

press START. A non-cutting red laser spot will be emitted instead of the invisible carbon-

dioxide laser and trace the cutting/engraving path. You can increase the cutting speed 

temporarily to expedite this check. Make sure you reset the speed before cutting/etching. 

7. Cutting, stopping and pausing: When you’re ready, close the lid and press START. If you 

want to stop the process prematurely or temporarily, raise the lid or press PAUSE. The former 

option provides the fastest response, but you can’t resume. Press the PAUSE button to home the 

head after completing the present operation. Raising the lid will stop the carbon-dioxide laser 

immediately; pressing PAUSE without raising the lid might take awhile. You can press the 

PAUSE button again to resume the job from PAUSE,  or you can start over by pressing 

START. Raising the lid, then pressing PAUSE stops the cutting path after the laser has been shut 

off, and you cannot resume the cut. 

8. Don’t leave lid open: The laser stays “warmed up” and quieter with the lid closed. 

 

1. CUTTING MODES WITH THE LASER CUTTER:  There are two modes of operation, vector 

and raster. In raster (engrave) mode, the head sweeps back and forth, “filling in” the shape, a (fat 

line, a filled polygon, or a bitmap image). In vector mode, which creates thin lines, the head traces 

the vector path. Use raster for engraving and vector for cutting. The vector mode will cut only 

along thin lines of near-zero width, whereas the raster mode will try to fill everything designated 

with that color, including filled areas, alphanumeric characters, and thick lines. Be careful about 

not leaving a cut-enabled vector outline to your engraved polygons. You may end up with a cut-

out polygon! This is easy to forget. 

2. With material that is not opaque, you’ll know you’re cutting completely through the material when 

you see the aluminum honeycomb cells fill up with smoke. You also will see short, bright flashes 

of light when the laser hits the honeycomb edges after cutting through a clear or translucent piece. 

If you don’t observe either of these, you’re probably not cutting completely through.  

3. When cutting completely through material without protective film placed atop the honeycomb, a 

faint but permanent outline of the honeycomb might be visible in the vicinity of the cut line on the 



bottom of the piece being cut. If you don’t want this, elevate those pieces with scraps or leave the 

protective paper or film on or place a sheet of paper between the honeycomb and plastic. Make 

sure the elevated objects aren’t in the cutting path. Don’t crash the head into the elevated piece. If 

you don’t cut completely through the piece but have to break plastic (especially acrylic) to release 

the part, the broken edges should be filed down as they can be as sharp as broken glass and 

cause injury if sharp edges are not removed. 

4. The energy used to cut or engrave is a function of laser power and inversely to the speed set in the 

Print ->Properties dialog box. There is also a direct relation to PPI though it’s probably best to use 

1000 PPI when cutting. Use just enough energy to do the job. These notes and the ULS manual 

provide a starting point for some materials. Laser pulses are metered synchronously to the head’s 

position, so multiple passes will yield the same spatial pulse pattern. 

5. The laser-cutting order, from first cut to last is: 

a. All rasterized engraving operations first, as drawn from back to front in the same 

color, then in color order, as listed in the laser Properties setting. For example, black 

areas will be engraved before red areas. Overlapped engraved regions will receive 

only one pass. 

Ghosting of other layers, both vector and raster, can occur within an engraved area. 

It’s best to engrave with only one type and color per area—no overlapping raster or 

vector objects within an engraved area—to be safe. 

b. Vector, cutting operations follow, from back to front depth order, then in color order 

as listed in the Laser Setting. For example, all black lines will cut before any red 

lines. Multiple overlapping lines will receive multiple passes. 

Part cutouts should be done after all internal part operations are completed. 

Otherwise, a slight offset from part movement may result. Sometimes, the gases 

produced accumulate in the honeycomb cells, and small explosions might occur, 

popping the part up, and sometimes over, if it is completely released. Cut the part out 

last. 

6. Importing your data into Microsoft Office Visio®: 

You can use virtually any 2-D drawing package (free Inkscape is a popular one) that outputs files 

in the following formats: .igs, ,dxf,  .dwg, .dgn, .ai, .emz, .cmx, .cgm, .cdr, .eps, .emf, .png, .ps, or 

.wmf. Visio will import most bitmapped files, or you can use programs such as CorelTRACE, 

InkScape or Vextractor to produce a vector outline as a .wmf or .dxf file from a bitmap. If you use 

a different CAD package, learn what formats work. 

7. Drawing in VISIO: Here’s a start at a usable Quick Access Tool Bar you can use in VISIO that 

has all the tools you need to create drawings for the laser cutter. Under File/Options/Quick 

Access Tool Bar, download and import the “LaserQuickAccessToolBar.exportdUI” file from  

\\hardlab-laser01\public\VisioDrawings\LaserCutterTips&Tricks or, choose All Commands 

and manually Add the following commands: 

../LaserCutterTips&Tricks


 
8. Printer settings: Note: Our crack IT department has created a startup file that should setup all of 

these as defaults automatically.  

a. The Visio Print Setup must be set up for a 32” x 18” printer and drawing size which 

is the size of the cutting bed of the PLS 6.60 laser cutter. If you can’t get past this 

stage, don’t print! Perform a Print-Preview to check. It may ruin your material 

if there’s an error. The VISIO auto-startup file on MSR Hardlab-Laser01 and 

Hardlab-Laser02 computers should do the following: 

i. Choose the P6.60 printer. 

ii. In Print Setup, choose User Defined Landscape and Adjust to 100 percent. 

iii. In Page Size, choose Custom Size, 32” x 18”, Landscape 

iv. In Drawing Scale, choose 1:1. 

 Make sure the above is correct and do not proceed until this is correct! 

Note: if you are having problems with the above, check Home->Options-
>LaserCutterSettings. You should see “User-Defined LANDSCAPE” filled in as Page 

Size. This is a common problem where it is left blank.  

b. Use different colors for lines and engraving fills to designate different power, speed, 

and PPI setting operations. Power, speed, and PPI for each of eight preselected colors 

can be set in File->Print->Properties->LaserSettings. The colors, in cutting order, are 

black, red, green, yellow, blue, magenta, cyan, and orange. These can be set for raster 

(engrave) and/or vector (cut), or skip (off) in the“Laser Settings described above. 



The colors must be pure. Use only colors such as RED = RGB 255,0,0 and BLUE = 

RGB 0,0,255, YELLOW = RGB 255,255,0…...  

c. A single color setting applies to both vector and raster operations drawn in that color. 

The raster and cut depths are not the same for power, speed, and PPI. It’s best to keep 

engrave and cut colors separate (IE avoid using the Rast/Vect setting for a single 

color). 

d. For the Quality/Throughput setting, use 5, the highest setting, in Print Properties. The 

‘6’setting has caused us weird scaling and offset errors. 

e. If engraving a gray-scale image (using the color black), the engraving power will be 

inversely proportional to the gray level, where black will result in the highest 

power/deepest  engraved depth. 

f. If cutting closely spaced features, high powers and low speeds might cause 

distortions or re-melting of these features, especially along the thin walls separating 

the pieces. Use multiple passes at lower power and/or cooling off periods between 

cuts on adjacent sides of thin features. NoLaserActionPauses can be implemented by 

slow speed and low power in scrap areas.  

You should be aware that Delrin is extremely susceptible to catching on fire 

and not self-extinguishing under these conditions. When cutting close to a 

recent cut, such as a thin wall, or cutting close to an edge, in our experience, the 

thin piece might/will catch on fire with a dim blue flame and might not go out 

immediately. In our experience, you can avoid this situation either by not cutting 

near thin pieces or close to an edge or by delaying the adjacent cuts on thin-wall 

features. You can force a vector color change to cause a pause when cutting lines 

near each other. 

 

 
 

Based on our experience, we strongly recommend you avoid cutting where 

thin pieces of Delrin will result that could catch fire easily (becomes 

“kindling”). In the above diagram, the black lines are cut first, then the red 

lines. If there are other black and/or lines in the diagram, this will insert an 

effective delay between when these black and red lines are cut, enabling the thin 

part to cool down between cuts. Alternately, you can execute a PAUSE – a slow, 

low-power vector cut in a scrap area to generate an effective pause between 

colors cut. We also recommend this for other materials as well. 

 

Another tip to reduce thin-wall heat distortion is to leave small “tags” that will 
continue to support the thin structures through cutting. When done with the thin 

structure cutting, use a single pass to cut through the tags. The example below 

demonstrates this. The cutting order is red, green, blue, cyan and magenta as the 

final tag release cut. The multiple thin wall structure cuts are separated in time 

with multiple colors. They are also supported through cutting with small (~.03”) 

“tags” that keep them aligned where they would normally be heat distorted if 

released. The final operation (before the final outline cutout) is to cut the tags 

(magenta) free with a single pass.  

+



 

 
g. In Print->Properties->LaserSettings, you can choose Skip, Vect/Rast, Vect, or Rast 

for each color.  

i. Skip will result in no action to objects drawn or filled in that color.  

ii. Vect/Rast will raster/engrave fat lines and filled areas and vector/cut thin lines. 

I don’t recommend using this. You should explicitly direct the operation as a 

cut or an engraving. 

iii. The Vect operation will only cut thin lines. Fat lines or filled areas will be 

ignored for a Vect operation. 

iv. Rast will raster/engrave fat lines and filled areas. It also will try to 

raster/engrave any thin lines in that color. 

I usually use only Rast for engraving only and Vect for cutting only and use 

separate colors for engraving and cutting to keep these operations separate. 

9. Engraving will produce a rough surface. Don’t expect to engrave a filled polygon and end up with 

a smooth finish at a precise depth within the polygon. Engraving also takes quite a bit of time. 

a. For raster/engraving acrylic with no masking required to avoid fogging, try 10 

percent power at 50 percent speed.  

b. Masking - When engraving, the heat and effluent gases produced might cause 

discoloration and/or permanent distortion to un-engraved surfaces nearby. Use the 

protective film or masking tape over these areas to protect un-engraved areas. Burned 

masking tape itself can cause discoloration, so experiment. To help smooth (melt) an 

already-engraved area, print the same image but at 50 percent power and 50 percent 

speed and ~0.5” out of focus (further away). For vector marking (engraving thin 

lines) acrylic with no masking required, try less than 50 percent power at 35 percent 

speed and experiment. The laser maker recommends covering unprotected plastic 

with thick dish soap before cutting or engraving then rinsing off afterwards. 

c. For some reason, the laser cutter might not engrave small areas. Specifying less than 

200 dpi might help. Starting on a larger engraved area might help. Experiment. 

 

10. Cutting/Engraving recommendations: Cutting - use the 2” FL lens, at 1000 dpi— 

Most plastic material can be purchased locally at TAP Plastics, 12021 Northup Way, 

Bellevue, WA. For larger and lower cost quantities, try Calsak Plastics in Seattle. 

Light vector engraving of Delrin, acrylic or polycarbonate - use power 20 percent, 60 

percent speed. 

CUTTING, suggested starting values (Note ‘P’ = Power, ‘S’ = Speed) YMMV so 

experiment! 

Avoid cutting any features smaller than ~~.025” as they will probably not turn out. 

a. 0.125” Delrin: P=100, S=2. 

b. 0.25” Delrin: P=100, S=1.3. 



c. 0.517” Delrin: P=100, S=0.5. Try to focus ~0.2” below the top surface. It might take 

two passes. Watch for dim blue flames that don’t automatically extinguish! 

Don’t repeat a cut until the previous cut has cooled. 

i. For cuts that leave thin walls/pieces (<1/8”), trim the vectors into multiple 

pieces and colors so one side of cut is executed after the other to enable 

cooling in between. Cutting too close in time and distance can cause severe 

deformation. 

ii. Make sure all cuts are done so previous passes have time to cool. You can 

implement an effective delay by cutting a different color line with 0.5 power 

and 0.5 speed. 

Suggestions only. YMMV: 

d. 0.046” acrylic: P=100, S=7. 

e. 0.114” acrylic: P=100, S=2.5 

f. 0.232” acrylic: P=100, S=1.4. 

g. 0.440” acrylic: P=100, S=1.0. 

h. 0.022” polycarbonate: P=100, S=30. 

i. 0.116” polycarbonate:  P=100, S=2. Leave protective film on until after cutting to 

reduce yellowing of the surface near the cut. 

j. 0.133” styrene: P=100, S=2. Expect slightly yellow edges. 

k. 0.11” rubber: P=100, S=1.5. Wash thoroughly afterward to remove black, sooty 

residue. 

l. Xerox transparency film: P=20, S=20. Use two passes at P=10, S=20 for intricate 

features. Anchor the film with small weights well outside cutting boundaries to 

prevent warping and moving from air currents. 

m. Aluminum tape: Cut from the non-aluminum side at P=100, S=3. 

n. Aluminized Mylar film: P=40, S=30.  

o. Cutting 3” camera-case foam: P=100, S=1.   

p. Engraving acrylic (suggestions only): 

i. 0.150”: P=50, S=8. 

ii. 0.078”: P=50, S=20. 

iii. 0.053”: P=50, S=30, 

iv. 0.043”: P=50, S=40. 

v. 0.036”: P=50, S=50. 

vi. 0.030”: P-50, S=60. 

q. Engraving paint on metal:  

i. Raster: P=40, S+100, 150 PPI. 

ii. Vector: P=40, S=20, 1,000 PPI. 

11. Miscellaneous cutting recommendations 

a. 0.115” birch plywood: P=100, S=4. 

12. Discoloration and/or surface problems near cuts: It might be helpful to leave the protective 

paper/plastic film on the plastic while cutting to preserve the quality of the surface. Just remember 

that you’ll have to peel the cover film/paper off manually, so try to leave a continuous surface to 

make the film removal easier. Placing wet tissue paper or painting on a thick liquid detergent over 

the material helps reduce this problem. The manufacturer suggests that a thin coat of dishwashing 

soap will reduce this problem. Let dry, cut, and wash afterward. 



13. Caution again – plastic that is not cut completely through but forced to separate (IE hammering to 

break apart) can leave V E R Y sharp edges, as sharp as a freshly sharpened knife. FILE THESE 

DOWN before using or it can cause serious injury. 

14. Removing small parts (wanted and/or unwanted) – For removing many small parts (IE screw 

holes), the hole centers will many times be slightly raised (on one side of the plastic) but still 

attached to the sheet. Place the raised side down on a flat surface and hit with your hand with a 

medium force. All the hole centers should pop out. Sometimes just hitting the cut sheet against the 

table or edge of a waste can will dislodge them. If some of the small parts are to be saved but 

indistinguishable from the scrap, put a superficial etched mark on them like an “X”.  

 

VISIO (and other CAD programs) NOTES: 

 

Microsoft provides the following information for your benefit. We recommend that you 

experiment or test a given method to ensure that it produces the proper result. YOU USE THIS 

INFORMATION AT YOUR OWN RISK. MICROSOFT DISCLAIMS ALL RESPONSIBILITY 

FOR HARM OR DAMAGE TO YOU, YOUR MATERIALS, AND/OR YOUR LASER CUTTER. 

 

 

1. Using AutoCAD’s .dxf files (works most of the time): 

a. Insert-> CAD (specifying Files of Type .dxf). 

b. Edit (or right-click) the object ->CAD Drawing Object->Convert->OK to convert to the 

Visio format. Use defaults. 

c. Select and Ungroup all objects. 

d. Delete the drawing frame (it’s sometimes invisible rectangle around the drawing). 

e. Select the rest of the objects, which might have invisible lines, and choose an appropriate 

line color. We have noticed on our laser cutter, black is the only color choice. Sometimes 

this strange behavior can be cleared by choosing the Line tool and selecting the object. 

f. Check for correct scale and correct if necessary. 

g. Make sure the scale is correct.  

h. Curved lines are usually made up of many tiny lines (polylines). 

i. When subsequently trimming/ filling/Boolean operations, you may note some unusual 

behavior such as inverted or inside-out polygons. Try to correct these by removing the 

offending lines.  

2. Vector Cuts: Zero-width lines cause the laser to trace the line (cut) when in the vector cut 

mode. Use Format->Line->Weight->Custom = 0.  

3. Polygons: Inside/outside does not have significance when cutting. The kerf is of finite width 

and there is no tool compensation available as there is in CAM for a milling machine. You 

must add this compensation manually if it is important. The laser will trace any cut-enabled, 

zero-width line. If you’re engraving a polygon, you must fill it with an engrave-enabled 

color, and inside/outside will dictate what gets engraved. Turn off the perimeter line 

(specify No Line), or the polygon will be cut out after engraving. 

4. Origin: 0,0 is at the upper left of the 32” x 18” workspace. Stay at least 1/8” away from the 

cutter’s aluminum borders. Place drawn objects no closer than 1/8” to the X and Y axes. 

5. Environment: (Note – our great IT department has generated an automatic startup file to 

affect all laser cutter defaults) 



a. First, open a File->New Drawing. Before drawing anything, check/change the Line 

Weight (Format/Line/Weight/Custom) to 0. This enables the printer driver to turn all 

drawn lines automatically into thin vectors rather than trying to engrave a fat line. You 

can use a thicker line, but the cutter will try to engrave it. After you complete the 

drawing, select-all and make sure the formatted size for all cut-only lines is 0. 

b. Select No Fill in the paint-bucket icon for polygons or circles to be cut unless you want to 

engrave the filled area. If engraving without cutting the polygon, select No Line in the 

paintbrush icon, or the area will be cut after it’s engraved. 

c. Use the View->Size and Position window, in which you can enter numbers for size and 

offset. It executes immediate math: For example, it will replace 4+15/16 with 4.9375. 

6. Cutting Order: The order of laser operations is from back to front within the same color, 

then by color order (see PRINT PROPERTIES). Use these attributes (Shape-> Order and/or 

color) to specify the cutting/engraving order. If mixing engraving and cutting, the laser will 

engrave first. Make the part cut out the last operation (with Shape->Order->Bring-to-Front) 

to avoid material movement, because a part will move slightly when it is completely cut out 

7. Raster/engraving speed: When engraving multiple areas filled with a specific color, the 

head will sweep back and forth to include all horizontally overlapping areas. If these areas 

of like color are spaced far apart horizontally, it might take a long time to engrave. If 

possible, position these like-color engraved areas close together horizontally or arrange so 

there is little horizontal overlap. 

8. CorelTRACE (or, Vextractor, InkScape (free))  is great for converting a bitmapped 

image to a vector object. (flat-bed scan the object to a bitmap image and process in 

Photoshop or similar image editing tool). Sometimes the program will trace with multiple 

overlapping lines. In Advanced Trace, try Medium Complexity, Medium Node Reduction 

and Smooth Node Type with a large minimum object size, such as 300. I’ve had great luck 

in flat-bed scanning an object, tracing it, then cutting out a nearly identical part. If you need 

to compensate for the lost material in the kerf, I’ve used Photoshop’s Select->Modify-

>Expand or Contract by a discrete number of pixels to add or subtract a kerf amount. 

9. No Cut: If you don’t want specific objects on your drawing cut or engraved, make it a non-

cutting color or a dashed line, or simply position it completely off the 32” x 18” page onto 

the background. Make sure no objects or lines cross or straddle the 32” x 18” border. 

10. Hole-Cutting Example: Cutting a 0.162”-diameter hole in Delrin produces approximately a 

0.165”-diameter hole and a 0.154”-diameter slug, indicating a hole .003” too big in diameter 

and a slug .008” too small in diameter. This varies considerably. If it’s important, 

EXPERIMENT. 

11. Screw Holes: To cut holes for screws (tap, clearance, and body sizes), use this data in your 

CAD: 

Tap holes: subtract ~0.004” from the desired tap drill diameter for the kerf compensation. 

Tapping is a handy, strong, and quick way to fasten two pieces of laser-cut material together and 

to enable later disassembly. Using our fast tapping tool or a tap in a portable drill, apply light 

pressure on the tap in the tap hole, and the rotating tap will pull itself into the hole. When at the 

required depth, quickly reverse the direction to back the tap out. If you wait too long, the heat 

generated by the tap may melt some of the plastic, which then cools and solidifies. This might 

seize the tap in the plastic and break it when you try to remove the tap. For a Nyloc-like friction 

fit, use a tapered tap and don’t tap all the way through, to enable the inserted screw to thread itself 

through the small, untapped portion and provide a tight friction fit that will withstand vibration. 



Body holes: subtract 0.004” from the desired body drill diameter for the kerf compensation. 

Clearance-fit holes: subtract 0.008” from the desired diameter for the kerf compensation.  

   
SCREW TAP HOLES BODY HOLES  0.001" CLEARANCE HOLES

SIZE            VISIO VISIO DESIRED VISIO VISIO DESIRED VISIO VISIO DESIRED

RADIUS DIAM. DIAM. RADIUS DIAM. DIAM. RADIUS DIAM. DIAM.

2--56 0.033 0.066 0.070 0.042 0.084 0.086 0.039 0.080 0.084

4--40 0.0425 0.085 0.089 0.056 0.111 0.113 0.051 0.106 0.108

6--32 0.0515 0.103 0.107 0.069 0.138 0.140 0.064 0.130 0.134

8--32 0.066 0.132 0.136 0.082 0.164 0.166 0.077 0.156 0.159

10--32 0.0775 0.155 0.159 0.099 0.197 0.199 0.090 0.183 0.186

1/4--20 0.0985 0.197 0.201 0.124 0.248 0.250 0.120 0.240 0.246

5/16--18 0.1265 0.253 0.257 0.155 0.311 0.313 0.152 0.303 0.309

3/8--16 0.1545 0.309 0.313 0.187 0.373 0.375 0.181 0.362 0.368

7/16--14 0.182 0.364 0.368 0.218 0.436 0.438 0.000 0.000

 

 Typical screw head and hexagonal nut, actual sizes 

Screw Pan Head Flat Head Nut Size Nut 

Size Diameter Diameter Flat-Flat Thickness 

2-56 0.165 0.160 0.185 .062 

4-40 0.209 0.209 0.245 .095 

6-32 0.260 0.253 0.308 .105 

8-32 0.314 0.302 0.338 .123 

10-32 0.371 0.346 0.370 .128 

1/4-20 0.483 0.468 0.438 .220 

 

12. Screw fastening at right angles: 

(This is not a new idea though nut retention may be.) Cut a “cross” shape in the bottom of 

the piece to be edge fastened. With pliers, press a hex nut with opposite flats parallel to the 

thickness dimension into the space for the nut. The cross should be cut so the nut fits tightly 

but not enough to crack the plastic. This will hold the nut in place while you’re trying to 

juggle the screw and two pieces of plastic. A screw can then be inserted through a body hole 

in the other piece to be fastened and tightened.   

 
 

13. Quick Bevel Cut: To produce a smooth, beveled finish atop a normal cut: 



a. Cut the part out normally. You might have to design small “tags” to hold the part in place 

for the next operation if the part will shift much after the initial cutout. Leave everything 

untouched in the cutter after the cuts. 

b. Lower the floor by 1.0”. 

c. Make a copy of the vectors you want to bevel, change to a unique color, and exactly 

overlay these atop your original object(s). 

d. (Optional if laser isn’t aligned vertically) Move these new vectors in X and Y on your 

drawing, up .01” and to the left by 0.015” (add -0.015 to X and +0.01 in Y in the SIZE-

POSITION window). This accounts for this machine’s vertical misalignment in AZ & EL 

(L/R) offset per 1.0” out-of-focus for our printer. Normally you don’t care as you would 

focus on the top of the material but for out-of-focus processing. This is not normally 

adjustable in most laser machines. 

e. Remove the protective film and vector-cut only that unique color at 2x to 4x speed, same 

power or a half to a quarter of total power. Keeping the film on will weld the film to the 

plastic. 

f. Return the floor back to the normal focus height. 

g. You may experience some removable or permanent fogging to the plastic because you 

removed the film. You can execute a superficial cut just through the protective film 

(~50% pwr, 100% speed) about 1/8” just inside the outside perimeter of the finished 

piece. Do this initially and remove the film from all but the inside area then execute steps 

a-f above.. 

h. Experiment 

i. My ULS Corporation suggestion – Please add final mirror adjustment screws to 

compensate for vertical beam skew past the focus point. 

14. Precision bending acrylic, Delrin or polycarbonate: 

This method can produce a near-perfect bend in thin acrylic, acetal or polycarbonate by 

using the laser to heat only portions of the plastic. The downside might be a weaker 

section of plastic at the bend. Experiment. The following works well for 1/16” 

polycarbonate: 

a. Cut out the part using regular cutting procedures. Keep the plastic’s protective layers on 

when cutting but remove for bending. 

b. Lower the workpiece 2” below focus position by using the FOCUS buttons. 

c. Draw two lines 1/16” apart, slightly longer (~1/8” longer on each end) than the place you 

want to bend. Draw the first line top down (or right to left) and the second, 1/16” away, 

bottom up (or left to right). Select these two lines and copy/paste 19 times. Select these 

19 copies, place atop the original 2 lines, and group all 20 copies—40 lines total—

together. This will cause the laser cutter to apply non-cutting heat in the area of the line 

without having the head retrace. Cut at 30 percent power and 45 percent speed for 1/16” 

polycarbonate.  

d. Immediately remove plastic and bend to desired position. 

e. For multiple bends, it’s best to do one bend at a time (change the color of the other bend 

places to a non-cutting color). Make sure the head won’t hit the piece. 

 

 

f. It’s great for making project boxes. Because any bending will consume a portion of the 

material, you will have to account for the material used in the bending. Experiment first.  



 

 

 

 

 

 

 

 

g. Laser Origami: My good friends and colleagues at Hasso Plattner Institute in 

Germany, created a technique where you can use gravity to automatically bend 

plastic at right angles. Check out http://www.hpi.uni-

potsdam.de/baudisch/projects/laserorigami.html . 

15. Making Lenses: Crude optical lenses can be made by rasterizing shapes in clear acrylic. 

Describe the lens’ Z-shape as a black-and-white gray-scale image—the darker the image, 

the deeper the engrave—and engrave in 3-D, out of focus. Use Photoshop to describe a 

radially symmetric shape in the CURVES menu. A radial linear gradient from white to 

black, with black in the center, will produce a conical concave shape. Change the gradient 

profile, using Adjust/Image/Levels, to approximate a circular arc to achieve a spherical lens 

output. Try cutting 1” (long) out of focus at 150 PPI, with power = 100 percent and 

speed=30 percent. Change to 3D in Print Properties. Shift the image by X = -0.015” and 

Y=+0.01” to compensate for the lateral angular shift when 1.0” out of focus. This will create 

a negative lens with a ~0.05” Z depth in clear acrylic. Return the Print Properties to Normal. 

16. Cutting thin materials: As the thin part is cut out, it might fly away, making it difficult to 

find and creating the potential for interference with subsequent cuts (or clogging your 

exhaust fan!). As a final operation, install a small “tag” on one or more of the lower parts of 

the outer-most cutout; a ~0.015” void in the cutout vector should work and is easy to later 

tear apart. Overlay a 0.015” square on the vector line, select it and the line, and choose 

Shape/Operations/Trim. Then remove the square and the 0.015” line to produce the uncut 

tag. 

 
 

17. Reducing fogging when etching: To reduce fogging (sometimes permanent 

marring of the plastic surface that happens when the gasses from etching touch un-etched 

plastic and causes fogging of the surface) you can leave the protective film/paper on but you 

may end up having to peel 100’s or 1000’s of isolated paper islands (no fun!) or remove the 

all protective film/paper and etch with a reduced power. Another method is to remove all of 

the top film/paper (so you won’t have to “weed” later) and brush on a thin film of thick 

liquid detergent and let dry. Etch your plastic then wash away the remaining detergent. 

Works great. For the backside, you can remove the protective film/paper and replace with 

0.015” void 

The laser cutter will trace 

this path 20 times, applying 

out of focus, non-cutting  

heat to the area. 

http://www.hpi.uni-potsdam.de/baudisch/projects/laserorigami.html
http://www.hpi.uni-potsdam.de/baudisch/projects/laserorigami.html


loose sheet(s) of regular paper. This will reduce the soot marking from smoke and flames 

occurring in the honeycomb bed. 

18. Intricate stencil for painting: Arrange a vector cut just through the paper or 

plastic protective film. Remove the film in areas you want to be painted. Paint with spray 

paint. Let dry. Remove rest of the protective film. You’ll wind up with a beautiful, 

professionally looking stencil. You can also raster the to-be-removed protective film with 

just enough power and speed to ablate the film, leaving unprotected, paintable areas. 

19. Annealing to remove residual stress:  Often, with many closely spaced cuts or 

deep etching, the plastic piece will come out warped. This is from thermal stresses trapped 

in the plastic. One way to relieve these stresses is to anneal at a high temperature. I’ve had 

luck putting the plastic in a constant temperature oven for a few minutes. Let ~1/4” Acrylic 

anneal at 100 deg C for around 5 minutes, resting on a flat surface in the oven.  

20. Vacuum forming: Molds and a vacuum-forming jig can be made quickly for 3-D 

heat-molding thin materials such as thin polycarbonate and acetate.  

 

                    

Material Hold Down Plate

Material to be molded

Mold

Vacuum Plate

Vacuum

 
Cut the material hold down and vacuum plates out of acrylic. The mold can be out of acrylic but 

will depend on what’s being molded. You may have to remove the berms on the acrylic cuts for a 

good seal. I’ve had luck using gray-scale images in the laser cutter and engraving out of focus by 

about 1”. This will make a smooth surface, but you can’t get much fine detail. Cut small holes 

(0.008”- 0.010”) in strategic places in your mold to pass the vacuum. Make sure to cut plenty of 

aligned bolt holes in all plates and molding material to clamp the fixture together and seal for the 

vacuum. Cut a tap hole in the vacuum plate and tap to avoid having to add a nut, but don’t over-

tighten. Once everything’s clamped and the vacuum is pump connected, use a heat gun to heat 

the top (the mold material) uniformly and distort to the mold shape. Allow it to cool before 

unclamping. 

21. Blind tap holes: For blind tap holes (threaded holes that don’t go all the way through the 

piece) in plastic (Delrin in this example), use concentric vector circle cuts, starting with the 

outside diameter as in the table above, decreasing the radius by .010” at each step, down to 

.010” minimum. In other words, for a #2-56 tap hole in Delrin, 0.033”, 0.0200”, and 0.010” 

radius cuts at 50 percent power at  2.5 speed will yield a ~1/16” deep hole per pass. Allow to 

cool, then tap, using a bottoming tap. Alternative: For a blind 4-40 tap hole, engrave at 

P=50, S=14 for 0.186” deep in acrylic. 

22. Blind Splines for hobby radio-controlled (R/C)  servo shafts, for example: 

These splines awork to be 24-tooth with varying diameters on many servos – check for your 

particular model as they do vary. You can use a 24-tooth gear as a close geometry. 
 



 
 

 

 

 

 

 
Blind-Hole splines in 1/8" DELRIN. Use 24-tooth gear as 

spline geometry:       

          

                       Use These Numbers in Visio               

Type 

Spline 

Radius 

Screw 

radius Power Speed Remarks    

Large servo .133"  100 45 raster (filled gear), 2 passes. .bmp image=.276" 

   .048" 50 2 Cut vector (.047" radius screw hole), 1 pass 

Medium 

servo .123"  100 45 raster (filled gear), 2 passes. .bmp image=.254" 

   .047" 50 2 Cut vector (.047" radius screw hole), 1 pass 

          

Through-Hole splines, 24 tooth:       

          

Type Gear Diam.  Power Speed Remarks    

Large Servo .245"  50 2.5 

Cut vector gear, 2 

passes    

Medium 

Servo .225"  50 2.5 

Cut vector gear, 2 

passes    

                 

 

23. Gears: You can make good spur gears with the laser cutter. Delrin is what we use for this 

because of its toughness and self-lubrication. Here is an inexpensive, clever gear-generator 

program: http://woodgears.ca/gear/. Note that the gears produced do not have any kerf 

compensation. The new version does have a variable called “Slop”. Entering a negative 

value will “grow” the outline, effectively causing a near-correct kerf compensation. The 

program is on our laser cutter computer. See also welding for stacking spur gears. 

24. Stacked and Welded Parts: You can make stacked parts (spur gears in this example) 

welded to each other. You can also do this for other non-gear items as well. For gears 

(Delrin is the preferred material), start by making your gear pair using apps like 

woodengears.com (a great program!!). Make sure to add “slop” to add back the kerf, 

especially for smaller gears. Cut two acrylic disks about 20% larger than their respective 

gears. Make sure there are no berms on the edges that would not let them stack in surface-

to-surface contact.  

“24-tooth 

gear” diam. 

 

Blind-Hole Spline            Through-Hole Spline 

2x “24-tooth gear” 

radius 

 

2x screw radius 

http://woodgears.ca/gear/
http://woodgears.ca/gear/


a. Place them in the laser cutter so they will stack with the larger disk against the X=Y=0 

edge.  

b. Concentrically stack them as shown.  

c. Cut the axis hole with correct focus, power and speed that will go through both 

thicknesses.  

d. Cut the small gear with appropriate focus, power and speed to go through the top layer 

AND only through part of the bottom layer. This causes the layers to be welded to each 

other at the cut location…..AS LONG AS THEY ARE CLEAN AND IN CONTACT. 

Remove any berm keeping them from lying face-to-face. 

e. Cut the larger gear with the power and speed to cut through a single layer. 

f. Carefully pry apart the smaller disk’s outside part to remove it. 

g. Depending on the calibration of your laser, non-circular hole results, etc, you may have to 

experiment to add offsets to insure the gears and axis hole are concentric, especially for 

smaller gears. 

 

 
 

25.  Smallest Feature Size: Visio (or the ULS PLS6.60 printer driver) doesn’t appear to pass a 

circle of less than 0.008”diameter. No object will be cut below this dimension. Also, if you 

need to cut a very small hole (< ~.050”), use concentric circles to ablate the hole as you may 

not be able to remove the remaining slug. As an example, draw concentric circles of 

diameter = .045”, .035”, .025”, .015” for an approximate .050” hole. 



 

26. Delrin roller bearing example (as shown in the library .vsd drawing): 

a. Bearing diameter: Cut 8x  0.1104”-diameter (0.0552” radius) roller bearings. 

b. Cut inner sleeve: 0.108” I.D. (0.054” radius), 0.178” O.D. (0.089”  

radius). The I.D. will accept a 4-40 screw for mounting. 

c. Cut inner race of outer part 0.37” I.D. (0.185” radius). 

d. Mark (‘X’) the top of every part. Rollers  assemble  

upside down with regard to races. 

e. Cut two inner-sleeve geometries out of Xerox 

transparency material or acetate film for spacers. 

Spacers can also be realized by leaving the 

protective film on in the correct places on the 

bearing holders. This is done by laser scoring and 

removing just the film in areas where the thin 

spacer is not needed. This works very well. See 

Easy Shims below. 

f. Easy Shims (thin spacers): To make thin spacers for clearance, leave part of the 

protective foil/paper on the plastic ( ~ 0.002” per film layer) . For example, to 

make a pulley where the sheave rotates even though the cheeks are fastened tightly 

with screws, leave areas of the cheek parts with the protective film/paper intact. 

Use low power/high speed to just cut through the film on sections that don’t need 

to be cut through the plastic: 

. 

Leave protective
film on here

Clearance for
sheave to rotate

Protective
film shims for 
spacers

Sheave
axel

 

 

27. Small bearing race (or O-Ring groove): This is 

tricky but works well (for this particular laser cutter at 

least). Start with this - The race is “cut” as vector 

circular paths with the lens 1.0” out of focus. Position 

the table 1.0” lower than the focus point. At this 

grossly out-of-focus position, the laser beam cuts a 

smooth, wide, rounded bottom trough. The beam has 

an astigmatism, as well as a slight angular Z-axis 

misalignment when out of focus (to the lower right in 

our case) which must be accounted for by moving the 

drawn race feature to the upper left. It’s important to 

make all measurements with regard to the desired 

center. The following is based only on our laser cutter 

that has a tilt to its beam in X & Y. YMMV. 



a. Draw a desired race-diameter circle (use a non-

cutting color) line for non-cutting) where you want 

the bearing race to be.  

b. Draw two additional race-diameter circles (solid 

lines), one 0.015” to the left and one 0.015” to the 

right of the original race circle. Group these two, 

and make them a separate color from each other. 

You now have two circles, 0.03” apart in X. This 

partially corrects for the beam’s astigmatism.  

c. Displace this two-circle group by 0.015” in the –X 

direction and 0.010” in the -Y direction (displace 

toward the upper left). This compensates for the 

misalignment of the beam along the Z-axis when 

mis-focused (long) by 1.0”. Do not scale or rotate 

the result! Use these same displacements for all race 

sizes. 

d. With the system out of focus (long) by 1.0” (use the Z button in the Focus mode), 

vector-cut the two displaced circles at 100 percent power, 10 percent speed, and 

three passes for Delrin, two for acrylic (The number of passes is variable, but this 

seems to work for 3/32”  -> 5/32” ball bearings obtained at the hardware store). 

For acrylic, make two passes per side. This will be just deep enough for 3/32” ball 

bearings and a 0.022” polycarbonate bearing keeper. 

e. Raise the table back to focus height, taking care not to crash the head, and cut the 

center hole, the outer diameter, and anything else that needs to be cut or engraved. 

Make sure the part cut out is last, or a small displacement error might result. 

f. A bearing keeper can be cut out of thin (0.022”) polycarbonate. Cut holes slightly 

larger than the balls. 

 

28.  Snug Fit: For a tab-in-slot snug fit in ~0.2” acrylic, cut the slot ~0.012” smaller than 

the thickness of the acrylic. You may have to experiment. Remember the entrance 

size of a hole will be larger than the exit (bottom) when cutting through. See the 

section on KERF. Be sure to experiment. 

29. Press fit for ¼-20 cap-screw head: Use a 0.179”-radius (0.358”-diameter) hole in 

acrylic. Groove the screw head parallel to the screw shaft with the Dremel cutoff 

wheel or grinder. This should help relieve the pressure and provide additional holding 

force to the plastic. Gently tap the screw head into place, entering from the laser 

(larger-diameter) side. This is good for making a fixed, screw-in plastic knob. 

30. Smooth, Wide Groove: A relatively smooth groove can be produced with equally 

spaced lines cut out of focus. Cut as parallel vectors, 0.028” apart, 2” out of focus 

(long). Avoid cutting adjacent lines sequentially to allow for cooling. Color adjacent 

vectors with sequential colors—allow to cool between cuts for short grooves. You 

can use zero power cuts after regular cuts and use multiple copies. P=7, S=10, 1000 

PPI yields about 0.014” of cut depth per copy in acrylic. 

31. Removing solder mask over copper from a printed circuit board: Engrave the 

area to be removed at P=50, S=100, 500 PPI. Scrub off remaining film with acetone. 

Acetone won’t touch the un-lasered solder mask. Be careful not to engrave over any 



non-copper-filled areas, because engraving directly on FR4 material will burn and 

turn it to conductive carbon. 

32. Flexible, multilayer printed circuit board: A workable PCB can be made using 

aluminized Mylar film. You should know which side of the Mylar is conductive 

(sometimes both sides are but insulated from each other. Investigate with an 

ohmmeter) Also, the aluminum coating, a few 10s of nm thick, is easy to scratch and 

break electrical connection so handle with care. Start with a flat plate of metal 

(aluminum works fine). Thoroughly clean it and coat with a low-tack spray 

(repositionable) adhesive. Bake it in an oven at ~100 deg C for around 15 minutes to 

make sure the adhesive sticks to the plate which also reduces the tackiness of the 

adhesive to around that of a PostIt Note. This is to keep isolated pieces from flying 

away when being cut. Apply a piece of aluminized Mylar to the sticky plate and 

thoroughly press it to the plate so all parts stick. Use a roller. Be careful not to scratch 

the aluminum coating. Laser cut (suggest P=40, S=30 for a start) your first layer 

outline. Weed (remove) parts of the film that aren’t wanted. Press clear tape (clear 

packing tape works) over the remaining circuit and press/rub all areas firmly so that 

the tape sticks to all parts of the circuit. Carefully remove the tape from the plate 

which should bring with it all circuit parts, fixed in their original arrangement. Apply 

the tape to your desired substrate. Electrical connection can be made with conductive 

ink or epoxy. For multi-layer circuits, apply a piece of double-stick tape to a clean 

metal plate. Laser cut apertures where you want vias (vertical electrical connections) 

between adjoining circuits. Remove the tape from the plate and apply it to the 

conductive side of the circuit produced above. Apply a small quantity of conducive 

epoxy to the middle of each via and apply the next circuit layer, conductive side 

down, to the aperture film side. Procedures can vary – experiment! 

33. Bi-color etchings on Metal or Plastic: Paint a piece of metal or plastic painted with 

a contrasting color then etch through the paint with a vector cut or etch - makes a 

beautiful “etching”. Etching through the colored layer in anodized aluminum can also 

produce a finely etched drawing. 

34. Stencil on Metal or Plastic: Painting just where the laser cuts/etches: -   

a. Plastic: With the protective paper/film still on both sides, etch through just the top 

protective paper or plastic film on acrylic or polycarbonate. 

b. Plastic: Spray the plastic with etched paper/film attached with a contrasting color 

paint.  

c. Plastic: Remove protective paper/film after the paint dries. 

d. Metal or Plastic: If you have a very detailed etching (removing the protective film 

pieces will take too much time), remove the top layer of protection film or paper if 

present and paint on a coating of dish soap. Let it dry. 

e. Etch your pattern through the soap layer and into the metal or plastic 

f. Spray paint it and let it thoroughly dry. 

g. Under a stream of water, scrape off the paint coated soap layer with the straight 

edge of a softer plastic scraper (ABS, Delrin, Poly), leaving only the painted 

recessed parts. 

35. Heat stress causing sheet stock to warp: Many times when cutting a lot of parts out 

of large pieces of sheet stock, the accumulated heat built up in the sheet over a short 

time will cause unequal top/bottom mechanical stress, resulting in the sheet warping 



out of plane and may result in these cuts being cut grossly out of focus and/or 

alignment. This can be mitigated by placing weights (or otherwise clamping) on the 

non-cut part to stay in-plane. I use a heavy thin steel bar that I lay over the sheet 

stock. First verify the lens carriage won’t hit the bar. Do a practice cut without the bar 

to the verify path of the lens carriage before you cut. I use a thin enough bar that the 

carriage head won’t hit but pass over it. 

36. Generating  Vector Fonts:  

Generating vector text for laser cutter (one method, uses free InkScape) 
a. (not the fastest as just typing but beats tracing rasterized fonts) 

b. Open InkScape 

c. Go to Extensions/Render/Hershey Text 

d. Render text 

i. Choose Live Preview 

ii. Font Face – choose a font 

iii. Action – “Typset that text” 

iv. Text – enter a line of text 

e. Select Apply 

f. Select and copy the line of text rendered to the InkScape screen 

g. Copy into your VISIO document. 

h. Make sure to reduce the line width to 0 if you want it as a “cut-able” vector 

37. Marking drill guides: If you will need to drill parallel to the plane of the sheet plastic (edge 

drill), you can make an accurate marking by vector cutting a superficial marking line on 

your piece. If I need to drill into the edge of my piece for threading a screw for example, I 

mark a line on the plastic using 20% power + 20% speed. This way I can see the line and 

line up the drill press and guess at the midpoint of the thickness of the plastic. Another 

method is to make a short cut (~.01”) across the edge of the plastic I later want to drill. If I 

use cut-through values, I will wind up with a very thin “notch” where I need to drill which is 

easy to find and start with drill bit. 

Drill

 
 

38. Cutting through with fine detail: If you want to cut through material with fine detail and small 

space/trace widths, consider etching with full power and slow speed rather than using vectors. 

This works best with non-thermoplastics (IE wood) materials. This also works great with intricate 

scroll work such as from a script font. Remember when designing in CAD, any uncut material 

you don’t want to fall through cannot be left as an island (enclosed with a cut perimeter). It’s 

probably best to convert to a raster image and make black all areas you want to remove. In the 

example below, an “S” rendered in Edwardian Script font produces 4 isolated uncut areas (white) 

surrounded by cuts (black) so those areas will physically drop out. Convert the object to an image 



and remove enough of the black cut lines to not isolate any areas you want to keep. Stencil fonts 

use this technique. 

S   =>   

39.  Camera use for placing drawings of objects to be cut/etched:  One of our smart interns, 
Andrew Wittenmyer, mounted a camera above and outside the cutting chamber. If you have 
a piece of material that has a number of cuts in it already and you want to keep using it and 
not waste any more material than you have to, this addition will place an image “under” 
your drawing and cannot be moved, scaled, rotated or deleted. All you do is press F2 (takes 
the picture and places it on your drawing) and move your CADed object where there’s uncut 
or unetched material and proceed to cut/etch. A great time-saver. 

 

Additional information: 

Plastic Instructional Videos by TAP Plastics: http://www.tapplastics.com/info/video.php 

 

TAP Plastics has a store in Bellevue, WA, at 12021 Northup Way, (near 20th Street), 

425-861-0940. There is also a TAP Plastics in Seattle near Westlake: 710 9th Ave. N, 

206-389-5900.  

 

In  Progress additions: 

 

Addition to AirAssist systems - the secret to clean laser cutting: Designing a better laser nozzle 

using 3D-printing | Nervous System blog (n-e-r-v-o-u-s.com)  (I have not tested this yet but am curious. 

Please let me know if you have tried it). 

 

Laser cut plastic PopOut tool.  I’ve spent far too much time poking out little internal parts like plastic 

washers I make in bulk or the centers of screw holes I cut by the 10’s or 100’s. Grind a cheap pair of 

deep throat pliers into a PopOut tool with a severe overbite like this: 

 Powerbuilt 7-Inch Self Adjustable One Hand Spring Loaded Pliers, All 

Purpose - Slip Joint Pliers - Amazon.com 

 

 

http://www.tapplastics.com/info/video.php
http://www.tapplastics.com/info/video.php
https://n-e-r-v-o-u-s.com/blog/?p=8722
https://n-e-r-v-o-u-s.com/blog/?p=8722
https://www.amazon.com/gp/product/B00G3GXPG6/ref=ox_sc_act_title_1?smid=A1EJ8NMVR00XQL&psc=1
https://www.amazon.com/gp/product/B00G3GXPG6/ref=ox_sc_act_title_1?smid=A1EJ8NMVR00XQL&psc=1

